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PRACTICALS 

Practical Title 

01 Arrangement of various gadgets and accessories of computer for 
its operations 

02 Create a Resume using MS Word 

03 Convert and print the information in the given paragraph in 
tabular form using MS Excel 

04 Create given Employability skills presentation using MS power 
point 

05 Create an E-Mail account and E-mailing a leave letter 

06 Self-Introduction 

07 Group Discussion-Online Learning 

08 Planning a day as a manufacturing worker 

09 Filling up the given SB ( Savings Bank) account opening form 

10 Mock Interview 

11 Writing a formal letter of application  for an employment 
advertisement in a newspaper 

 

 

 



 

Experiment:1 

Arrangement of various gadgets and accessories of computer for its 
operations 

Objective: 

To learn the procedure of connecting and disconnecting different external 
Input and Output devices with the computer. 

Operations Covered Under the Practical: 

 

Safety Measures: 

1. Before placing your computer on a desk or table, make sure it is set up near an 
electrical outlet and network. 

2. The keyboard should be reachable, the CPU should be well-ventilated, the 
monitor should be in full view and the mouse should be set up conveniently. 

3. Turn off the power and unplug equipment before performing service. 

4. Cover sharp edges inside the computer case with tape. 

 

 

 

 



Tools and Equipment required: 

Table 1 

Activity Title Name of the 
apparatus/ 

components 

Range/Value Quantit
y 

Identification of parts 
of computer 

Central Processing 
Unit 

I5-Dual Core 1 

Keyboard 108 Keys 1 
Monitor 14” LED 1 
Mouse Optical 1 
Printer Laser/Inkjet 1 
Switch box 3 Switch,3 

Socket 
1 

VGA Cable 1.5 Meter 1 
HDMI Cable 1.5 Meter 1 
USB Cable 1.5 Meter 1 
Power Cable 1.8 Meter 3 

Identification of
 the ports in 
CPU 

Central Processing 
Unit 

15 Dual core 1 

Connecting the 
devices 

Central Processing 
Unit 

I5-Dual Core 1 

Keyboard 108 Keys 1 
Monitor 14” LED 1 
Mouse Optical 1 
Printer Laser/Inkjet 1 
Switch box 3 Switch,3 

Socket 
1 

VGA Cable 1.5 Meter 1 
HDMI Cable 1.5 Meter 1 
USB Cable 1.5 Meter 1 
Power Cable 1.8 Meter 3 



 

Procedure: 

Section 1: Identification of Parts 

Table 2 

S.no Picture Parts 
Name 

Uses 

1 

 

Central 
Processing 

Unit 

CPU is work as brain of 
computer 

2 

 

Monitor Displays information in 
pictorial or textual form 

3 

 

Key board Putting information including 
letters, words and numbers 
into your computer. 

4 

 

Mouse To point at objects you see on 
the screen. 

5 

 

Switch 
box 

Used to supply from the 
power source to more devices 



6 

 

Power 
Cable 

Transmit the power from 
switch box to devices of 
computer 

7 

 

VGA 
Cable 

Used to connect and send 
signals between computers 
and monitors 

8 

 

HDMI 
Cable 

Used to connect and send 
signals between computers 
and monitors 

9 

 

USB 
Cable 

Used to connect other 
peripheral devices 

10 

 

Printer Used to print the documents 

 

 

Section 2 : Identification of Ports in CPU  



 

Figure 1.1 Identification of ports in CPU 

Step 1: Identify the power connector, SMPS cooling fan, CPU cooling fan, 
switch and screw. 

Step 2: Identify the PS/2 port, USB port, Parallel port, VGA port, Ethernet port 
and Audio jacks in CPU. 

Step 3: Identify the expansion slots and expansion cards in the CPU. 

Section 3: Connecting the devices 

Step 4: Connect the CPU and monitor using VGA or HDMI Cable, 

Step 5: Connect the Keyboard and mouse to the CPU (There may be USB type 
or PS/2 type), 

Step 6: Connect the printer data cable to the CPU, 

Step 7:Connect the power cables from the switch box to the CPU,monitor and 
printer. 

Step 8:Turn ON the power switches in the socket. 

Step 9: Turn ON the CPU power button to start the computer. 

 



 

Figure 1.2 Desktop computer 

Result: 

Thus the procedure of connecting and disconnecting different external 
Input and Output devices with the computer has been learned successfully. 

Table 3 
S.No Title/purpose Link 

1 Setting up a desk- top computer  
https://youtu.be/ KdQeU5QTfYE 

2 How to Setup a desktop computer 
at home 

 
https://youtu.be/ avaOf-kdb7w 

3 Computer Fundamentals - Setting 
up a computer - How to set a desk- 
top computers and how to plug In 
PC 

 
https://youtu.be/ SM0qsvQBEPg 

Video suggestions: 

Table 4 

Student project Students are asked to set up three computers. 
Guest lecture suggestions Invite a computer field technician for a guest 

lecture. 
Invite an IT engineer for a guest lecture. 

Industrial/ Field visit 
suggestions 

A Visit to a Computer center for field visit. 
A Visit to a software company for industrial visit. 

 



 

 

Experiment:2 

Create a Resume using MS Word 

Objective:  

To create a resume using MS office word. 

Operations covered under the practical: 

 

 

    Tools/Software and equipment required : 

Table 1 

S.No Name of the apparatus/ 
components 

Range/Value Quantity 

1 Desktop computer or laptop 
computer 

I5 processor/4GB 
RAM 

1 

2 MS Office Software Activated MS office 1 

 

Procedure : 

Section 1:Opening of MS Word: 



Step 1: Click the start button or press the windows key on your keyboard. 

Step 2: All programs > MS office > MS word  

Step 3: Double click to open the MS word application. 

Step 4: Go to file > New 

Section 2: Select the Template 

Step 5: Search for online templates will appear on the screen. 

Step 6: Search keyword “Resume” in the search box and select any 
template of resume. 

 

Figure 2.1 MS word Templates 

Step 7: Double click the template to use. 

Section 3: Replace the own Info: 

Step 8: Write the basic details such as Name, Mobile, E-mail & Address 

Step 9: Write the objective and Academic profile. 

Step 10: Write the person's personal details such as Father name, Date of 
Birth, Nationality, Gender & Language Known. 

Step 11: Write the declaration part of the resume. 

Step 12: Write the date, place and signature in the respective place. 



Step 13: Save the document by File > Save as and Select the location to 
save. 

Step 14: Rename the document and select the .doc file type. 

 

 

 

Figure 2.2 Sample Resume 

Step 15: Select the Save option. 

Conclusion:  

Thus the Resume has been created successfully using MS office  

 



 

 

 

 

 

 

Video Suggestions : 

Table 2 

S.No Title/purpose Link 

1 How to create resume using MS 
office 

https://youtu.be/Yeg29d5mxJY 

 

 

 

Scan QR Code to download sample Resume in .doc Format 

 

 

Experiment:3 
 

Convert and print the information in the given paragraph in tabular 
form using MS Excel 

Read the following paragraph and convert into the tabular form: 
There are 5 students namely Vetri, Samuvel, Mohammed, Akash and 

Joseph studying in class X. Their quarterly exam marks in Tamil subject 
was 98,89,80,92 & 98 respectively. In English subject, they got 
82,87,92,95 & 90 marks respectively. In Maths subject, they got 
89,92,90,88 & 91 marks respectively. In Science subject, they got 



85,75,90,95 & 90 marks respectively. In Social Science subject, they got 
95,90,85,87 & 98 marks respectively and their total marks are 
449,433,437,457 & 467 respectively. 
Objective:  

● To convert given paragraph information into tabular form using MS 
Excel. 

● To print the tabular form. 
Operations covered under the practical: 

 

Tools/software and equipment required: 

S.No Name of the apparatus/ 
components 

Range/Value Quantity 

1 Desktop computer or laptop 
computer 

I5 processor 1 

2 MS Excel Activated MS office 1 

3 Printer A4,Black and White, 
Laser jet printer 

1 

 

Procedure: 

Section 1: Read and understand the data in the paragraph 

Step 1: Read the information in the paragraph. 

Step 2: Understand the information in the paragraph. 



Step 3: Visualize the opted table in mind. 

Section 2: Enter the data in Excel sheet 

Step 4: Open the Excel sheet by click the Start button or Windows key 
>All programs >MS office >MS Excel. 

Step 5: Select the 6 Rows & 8 columns in the sheet. 

Step 6: Draw borders using All borders option. 

 

Figure 3.1 Table border draw 

Step 7: Type the information of S.no, Name, Tamil, English, Maths, 
Science, Social Science and Total. 

 

Figure 3.2 After the information typed in the Cells 

Step 8: Resize the rows & columns to make the data visible. 



Step 10: Align the data in the tables and the Bold the 1st row of a table. 

 

Figure 3.3 After the alignment of the sheet 

Step 9: Save the document. 

Section 3: Print the document 

Step 10: Choose the File > Print  

Step 11: Select the Print option and Print the document. 

. 

Figure 3.4 Print the document 



Conclusion:  

● Thus the data has been converted into a table form using MS Excel. 
● Thus the document has been printed successfully. 

Video Suggestions: 

Table 2 

 

Experiment:4 

Create given Employability skills presentation using MS power point 

Objectives: 

● To understand about presentation 
● To create the presentation in Ms office PowerPoint 
● To explore the few options in the MS Power point  

Operations covered under the practical: 

 

Tools and software required:  

Table 1 

S.No Name of the apparatus/ Range/Value Quantity 

S.No Title/purpose Link 

1 Excel Basics for Beginners in 
Tamil 

 

https://youtu.be/qNm_6iny
qQc 

2 Print and Page Setup in Excel in 
Tamil 

https://youtu.be/g8nc-
_LKB_I 



components 

1 Desktop computer or laptop 
computer 

I5 
processor/4GB 

RAM 

1 

2 MS Office Software Activated MS 
office 

1 

 

Procedure: 

Section 1:Opening of MS Power point presentation 

     Step 1: Open windows > search > MS-office PowerPoint and select it 

     Step 2: Open Power point > Select > File > New and Create a blank 
presentation 

 

 

 

 

 

  

 

Figure 4.1 Opening of MS power point 

Step 3 : Further add more slides in new slide to follow 

Step 4: Place a cursor inside a text box and type the content in the sample power 
point presentation. 



 

Figure 4.2 Start MS Power point presentation 

     Step 5: select the text and change font size and add  format option like bold 
option 

 

    Figure 4.3 Change font size and add format option 

 

Section 2:Enter the data in the given presentation 

Step 6:   Enter all the information in the presentation 

 
 



 

 
 

 
 



 

Step 7:  Save your power point presentation 

Conclusion: 

         Thus the given Employability Skills presentation has been created 
successfully by using MS powerpoint 

Video suggestions: 

Table 2 

S.No Title/purpose Link 

1 How to create power point 
presentation 

https://youtu.be/WJe_oYa3itE 

 

 

 

 

 

 

 

 

 

 

Scan the QR Code to download the sample power point 
presentation in .pptx format 



Experiment:5 

 Create an E-Mail account and E-mailing a leave letter 

Objective : 

● To create an E-Mail account 
● To E-Mail a Leave letter  

Operations covered under the practical: 

 

Tools/Software and equipment required: 

Table 1 

S.No Name of the apparatus/ 
components 

Range/Value Quantity 

1 Computer with Internet I5 Processor/4GB RAM 1 

2 Internet Browser 

 Eg.Chrome,Firefox 

- 1 

 

Procedure: 

Section 1:Creation of E-Mail (G mail) account 

Step 1: Go to the Google Account Sign In Page. 



 

Figure 5.1 Sign in page 

Step 2: Click the Create account option. 

 

 

 

 

 

 

Figure 5.2 Create account page 

Step 3: Enter your name. 

Step 4:In the "Username" field, enter a username. 

Step 5:Enter and confirm your password. 

● Tip: When you enter your password on mobile, the first 
letter isn't case sensitive. 

Step 6:Click Next. 

Step 7:Optional: Add and verify a phone number for your account. 

Step 8:Click Next. 

Step 9:Email Created. 



Section 2:E-Mail a leave letter 

Step 10: On your computer, go to Gmail. 

Figure 5.3 Sign in page 
Step 11:Sign into G-mail account by entering the Email and password. 

 
Figure 5.4 Interface of the Gmail 

 
Step 12:Click Compose option in the left corner of the Gmail interface 
Step 13: In the "To" field, add recipients. You can also add recipients: In 
the "Cc" and "Bcc" fields. To for Head Master’s E-mail ID,Cc for Class 
Teacher’s E-mail ID and Bcc for parents’ E-mail ID. 



Along with the "To" field of an email, you will usually have a 
place to enter email addresses in a CC field and a BCC field. CC stands 
for "carbon copy." BCC stands for "blind carbon copy."   

When you put an email address in the CC or "carbon copy" field it means 
that a copy of the email you are sending will also be sent to that 
address.When you put an email address in the BCC or "blind carbon 
copy" field it means that a copy of the email you are sending will also be 
sent to that address, but no one receiving the email will be able to see the 
address in the BCC field. 

Step 14: Add a subject as Regarding Leave Letter-Student 
name:MAHESH-18/11/2022 

 
Figure 5.5 Compose mail 

Step 15: Write a leave letter to The Head master. 
Step 16:At the bottom of the page, click Send. 



 

Figure 5.6 Writing of leave letter 

Conclusion: 

Thus the E-mail ID has been created and the Leave letter has been 
successfully mailed using Gmail. 

Video Suggestions : 

Table 2 

S.No Title/purpose Link 

1. 

 

Email creation 

 

https://www.youtube.com/watch?v=wm2k6rzUz54 

2. Send a mail https://www.youtube.com/watch?v=fCQBKKxjhcQ 

 

 

 

 

 

 



 

 

Experiment:6 

Self-Introduction 

Objectives : 

       To able to introduce oneself in front of others 

Procedure : 

Step 1: Introducing yourself can be an opportunity to introduce yourself 
in an interview or in front of others 

Step 2: Start with the greeting and thank for the given opportunity. 

Good morning, First of all, I thank you for giving me this opportunity to 
introduce myself. 

Step 3: Name and place should be mentioned first 

I am Karthik from Nadupatti,Salem 

Step 4 : Age and educational details should be mentioned next. 

I am 16 years old and I am studying 11th standard in Government Higher 
Secondary School, Nadupatti. 

Step 5 :Then tell About  the Family members. 

Let me tell about my family, we are four members in our family. My 
father, mother and an elder sister. 

Step 6 :Tell about the hobbies and extra-curricular activities. 

My hobbies are reading books and playing games. I have completed 5 
days Internship in State Seed production farm. 

Step 7 :Further brief about strengths and weakness 

I am a quick learner and I work hard.I have a sound computer knowledge. 
But I am introvert .However, I have started socialising now. 

Step 8:Tell about ambition of life 

My ambition is to become an Entrepreneur 



Step 9:Conclude by saying Thanks. 

Good morning all, First of all thank you for giving me this 
opportunity to introduce myself. I am Karthik from Nadupatti, Salem I 
am 16 years old and I am studying 11th standard in Government higher 
secondary school, Nadupatti. Let me tell about my family we are four 
members in our family. my Father, Mother and one elder sister. My 
hobbies are reading books and playing games. Also I have completed 5 
days Internship in State Seed production farm. My strengths are 
hardworking and quick learner. Also I have a computer knowledge. My 
weakness is I study a lot because sometimes I can't spend time with my 
family but I am trying to overcome this weakness I spent time with my 
family on holidays. My ambition is to become an Entrepreneur. 

Thank you. 

Conclusion: 

Thus, self-introduction is done successfully. 

Video suggestions: 

Table 1 

S.no Title/purpose Link 

1 How to Introduce 
Yourself? 

 

https://youtu.be/JZK1MZwUyUU 

 

 

 

 

 

 

 

 

 

 



 

 

 

  Experiment:7 

Group Discussion-Online Learning 

Objective:  

To engage in group discussion on the topic -online learning 

 Procedure : 

(After giving the topic, 10 minutes should be given for preparation) 

Rani: Good morning friends, we are going to discuss about online 
learning. During the COVID-19 pandemic, students were not able to 
attend schools and colleges. In such a situation, they continued to learn 
online since there was this wonderful option. 

Arun: With Online learning, teachers were not able to focus on all the 
students, which was possible in the classroom. Teachers could also not 
understand whether their students could grasp the concept or not. 

Anwar:  Online learning is a boon for many girls and the differently -
abled who were denied education due to various socioeconomic factors. 

Vignesh: Online learning gives flexibility. Even if we miss any class, we 
can listen to it later. 

Karthi: Students could repeat the lesson many times if they had not  
understood  the concepts. 

Anwar: As students have to look at screens continuously, it can strain 
their eyes. 

Sahana: In the classroom, students will not only learn the subject but 
also interact with other students and thereby make friends. Classroom 
influences the overall personality development of students. With Online 
learning, students will be deprived of this opportunity. 



Karthi: Through Online learning, teachers could explain the 
concepts using animations or other technologies, so that students  
understand the concepts much clearly. 

Rani: The classroom environment is lively in nature, whereas sitting in 
front of a computer or smartphone to listen to the classes will be boring. 

Vignesh: Even in this 21st century, some people do not have internet 
facility. So, online learning deepens the inequality between rich and poor. 

Sahana: Online learning may not create as much seriousness as classroom 
learning. So, students may not be motivated enough to listen to the class. 

Arun: Not all parents are technologically educated to help their children 
in case of any issues. 

Sahana: If the device has other apps such as Youtube, students may 
become distracted. Several students are already suffering from 
smartphone addiction. So, parents may not feel safe to leave the children 
unsupervised. 

Arun: As per our discussion, online learning has both advantages and dis-
advantages. We should understand that it has inevitably become a part of 
our lives. Technology can correct the dis-advantages of online learning 
and effectively use it in future. Thank you. 

Conclusion:  

Thus the topic on online learning has been discussed in a group 
successfully. 

Video Suggestions: 

Table 1 

S.No Title/purpose Link 

1 Group Discussion in English 
Confidence V/S Knowledge 

 

https://youtu.be/4WL9tzEl2Fw 

 



Experiment:8 

Planning a day as a manufacturing worker 

Objective: 

 To plan a day (24 hours) as a manufacturing unit worker of a company. 

Procedure: 

 Step 1: I shall wake up at 6 O’clock in morning. 

Step 2: I will take an hour to do routine work and morning chores. 

Step 3: I will watch the news and do morning exercise and walk with my 
pet dog until 7:30 a.m. 

 Step 4: I will spend another 30 minutes with my family members, helping 
to prepare breakfast and contribute for their needs and wellness. 

 Step 5: I will have my breakfast at 8 O’clock. After that I will go to the 
garden to water the plants. 

Step 6: I start my trip to the office at 8:40 a.m. I will reach my office at 
8:55 a.m. 

Step 7: After giving the attendance, I will check the list of programmes to 
do on that day. 

 Step 8: Up to 10:30 a.m. I will manufacture 200 numbers of palm plates 
and I will break for a while. 

Step 9: I will manufacture another 200 numbers of palm plates before 
lunch. 

Step 10: I shall have my lunch at 12:30 p.m. After that, I will 
manufacture another 150 numbers of palm plates before having yet 
another break. Then, I will  manufacture 150 numbers of palm plates until 
5 O’clock.  

 Step 11: I will have a get together with friends after my work hours.  

 Step 12: I will reach home again at 6:30 p.m. I will help my family 
members in completing the work. I will have play time with all members 
of my family. 



 Step 13: I will have my dinner at 8:30. p.m. with my family. After that I 
will spend my time helping with washing dishes and arranging things for 
the next day. 

 Step 14: I will go to bed at 10 p.m. 

Planning a day as a manufacturing worker in palm plate manufacturing 
unit: 

6:00 a.m. Waking up. 

6:00 a.m. to 6:30 a.m. Daily routine. 

6:30 a.m. to 7:30 a.m. Morning exercise and walk with pet dog. 

7:30 a.m. to 8:00 a.m. Spending time with family and helping to prepare 
breakfast. 

8:00 a.m. to 8:40 a.m. Breakfast and watering the garden. 

8:40 a.m. to 8:55 a.m. Travelling to the office.  (5 minutes to reach cabin 
and mark attendance) 

9:00 a.m. to 10:30 a.m. Manufacturing 200 nos. of palm plates. 

10:30 a.m. to 10:45 a.m. Break time. 

10:45 a.m. to 12:30 p.m. Manufacturing another 200 nos. of palm plates. 

12:30 p.m. to 1:00 p.m. Lunch break. 

1:00 p.m. to 3:00 p.m. Manufacturing 150 nos. of palm plates. 

3:00 p.m. to 3:15 p.m. Break time. 

3:15 p.m. to 5:00 p.m.  Manufacturing another 150 nos. of palm plates. 

5:00 p.m. to 6:30 p.m. Get together with friends. 

6:30 p.m. to 8:30 p.m. Playing games and spending time with family 
members. 

8:30 p.m. to 9:00 p.m.  Dinner with family. 

9:00 p.m. to 10:00 p.m. Washing dishes and arranging things. 

10:00 p.m. Go to sleep. 

 

 



Conclusion: 

 Thus I have planned a day as a palm plate manufacturing unit worker. 

 

 

 

 

Experiment:09 

Filling up the given SB ( Savings Bank) account opening form 

Objectives: 

 To be able to fill up the bank savings account. 

Tools and particulars required: 

  Application form, Pen, Passport size photograph, Glue, Photocopy of 
Identity proof. 

Procedure: 

Step 1: Do not fill the office use column.  It  will be filled by the bank 
officials only 

Step 2: Tick a checkbox in customer type and fill the personal particulars  

Step 3: Applicant name should be in block letters 

Step 4: If the applicant is minor,  fill a unique number of father and 
mother. 

Step 5: Write the corresponding and permanent address of the applicant 

Step 6: Fill the Applicant additional details in the respective fields 

Step 7: Attach photocopy of identity proof like Aadhar card, PAN card, 
Ration card for identification purpose 

Step 8: Applicants should have an introduction person to the bank and fill 
their details in the form. It is required for small account only. Not 
required if complete KYC requirements are fulfilled 

Step 9: Mandatory to give other account details in the same bank or other 
bank with signature of the applicant 



Step 10: After opening a savings account in the bank, we have to  fill 
Account opening form Part-II. 

Step 11: Fill the details of type of account, Details of Applicant’s name, 
Service required, and the specimen signature. 

Step 12: After filling  the application,  paste applicant’s passport size 
photograph in the required place 

Step 13: If account has been opened for deposit, then we   have to choose 
the type of deposit and write the nomination details if required 

Step 14: Read the guidelines terms and conditions carefully and sign in 
the applicant’s signature part in the form 

Step15: Finally, application form should be submitted to the bank officer 



 

 



 



 

 



 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Conclusion: 

 Thus the Bank savings account opening form has been filled successfully. 

 

 

Video suggestions: 

Table 1 

S.no Title/purpose Link 

1 SBI account opening form filling 
sample Tamil 

 

https://youtu.be/EPY57RWjXjI 
 

 

 

  

 

 

 
Scan the QR Code to download Saving Bank account 
opening form in .pdf format 

 

 

 

 

 

 



 

Experiment: 10 

Mock Interview 

Objective: 

To participate in a Mock Interview and address all the doubts and 
apprehensions that may arise in the mock interview. 

Procedure: 

 

Participants – Interviewer and Candidate. 

Step 1: Candidate Should Bring His Educational Certificate Proof and 
Employment Brochure. 

Step 2: Candidate should maintain Proper Dress Code. 

Step 3: When meeting the Interviewer, Shake hands with a Smile. 

Practice of Mock Interview: 

Interviewer: Good Morning, Raja. I am Sundar. 

Candidate: Good Morning. 

Interviewer: How are you doing? 

Candidate: I am doing fine. Thank you. 

Interviewer: That is good Raja, let’s start the interview. Are you ready? 

Candidate: Yes, I am. 



Interviewer: First of all, let me properly introduce myself. I am an Engineer 
cum HR. As you know there is an open position in my department and I need to 
fill this position as soon as possible. 

Candidate: Please, tell me a little bit about the position. 

Interviewer: It is an entry-level position. The new employee will have to work 
closely with the Technician department.  

Candidate: What type of qualifications do you require? 

Interviewer: I require a Two Year Course in Field Technician-Other Home 
Appliances. Some working experience would be helpful. 

Candidate: What kind of experience are you looking for? 

Interviewer: Doing office work is good. However, since this is an entry-level 
position, I do not require a lot of experience. I am willing to train the new 
person. 

Candidate: That is great! 

Interviewer: Raja, tell me something about yourself. 

Candidate: I have just completed a Field Technician Course. 

Interviewer: What are you looking for in a job? 

Candidate: The job should help me see what Finance is all about. I have learned 
a lot of Finance theories at school, and now it is time for me to put them into 
practice. 

Interviewer: Anything else? 

Candidate: I also hope that it will help me grow in my field. 

Interviewer: What are your strengths? Why should I hire you? 

Candidate: I am a hard-working person and a fast learner. I am very eager to 
learn, and I get along fine with people. 

Interviewer: OK. Now, let me ask you a few quick questions. You do not mind 
working long hours, do you? 

Candidate: No, I do not. 

Interviewer: Can you handle pressure? 



Candidate: Yes, I can. When I was going to school, I did a few other courses in 
the evening. And, I handled that situation very well. 

Interviewer: Do you still have any questions for me? 

Candidate: No, I think I have a pretty good understanding of the job. I believe 
that I can handle it with ease, and I hope to have the opportunity to work for 
you. 

Interviewer: Raja, nice meeting you. Thank you for coming. 

Candidate: Nice meeting you too. Thank you for seeing me.  

Conclusion: 

  Thus the mock interview has been successfully completed and the 
doubts are clarified. 

Experiment: 11 

Writing a formal letter of application for an employment advertisement in 
a newspaper 

Objective: 

   To write a formal Application Letter for the Job advertised in a 
newspaper. 

 

Procedure: 

Step 1: Check the eligibility for the advertised job 

Step 2: If the applicant is eligible for the job, send a letter to the company 



Step 3:  In the letter applicant has to mention sender and receiver’s details 

Step 4:  The applicant should specify the post applied for. 

Step 5: And write their educational qualification and mention their 
previous experience if they have 

Step 6: Further the applicant has to mention their skills and knowledge 

Step 7: The applicant's personal details and ability should be mentioned 

Step 8: Applicant has to give the own self declaration about the truth of 
the letter 

Step 9: Write down the place and date at the end of the letter with 
applicant’s signature 

Step 10: Finally, before posting the application, check the letter and post 
the letter with proper address on the envelope, and note that the letter has 
to be reached before the last date of the application. 

Sample letter format: 
 
 
 

Application for the Post of Field Technician 
From  

 M. Ravi, 
S/o. R. Murali, 
33-Raman Palakkadu, 
Vasavi Post, 
Erode -638301. 

To 
      The Hiring Manager, 
      R.K Home Appliances Service centre, 
      1, Ethiraj Road, 
      Chennai- 600008. 
Respected Sir, 

Sub: Post of field technician Reg 

I am writing to apply for the position of Field Service Technician, listed on your 
Newspaper Advertisement. With over 4 years of experience in field support 



positions, I possess the comprehensive skill set and hands-on understanding 
necessary to affect positive, overreaching outcomes in this role. Please review 
these points from my professional experience demonstrating my unique 
abilities: 

● I have Completed 12th standard in 2017.  
● I have done a course on field technician. ( Level 2) 
● I have 2 Years of working Experience in the relevant field 

The attached resume provides further details about how my qualifications 
and background is a match for your team’s needs in a Field Service Technician. 
I look forward to the opportunity and to discuss how I can contribute my 
strengths at your esteemed concern. I appreciate your taking the time to review 
my credentials and experience. 

Date :01.10.2022          
          Sincerely, 

Place: Erode          M.Ravi 
 
 
Conclusion: 
 Thus the Formal Application Letter for the Job advertised in a news paper 
has been written successfully. 
 

 

 


